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How to use this Competency Based Learning Material (CBLM)

The module, Creating Mock Up and Print contains training materials and activities for you to
complete. These activities may be completed as part of structured classroom activities or you
may be required you to work at your own pace. These activities will ask you to complete
associated learning and practice activities in order to gain knowledge and skills you need to
achieve the learning outcomes.

1.

Review the Learning Activity page to understand the sequence of learning activities
you will undergo. This page will serve as your road map towards the achievement of
competence.

Read the Information Sheets. This will give you an understanding of the jobs or tasks
you are going to learn how to do. Once you have finished reading the Information
Sheets complete the questions in the Self-Check.

Self-Checks are found after each Information Sheet. Self-Checks are designed to help
you know how you are progressing. If you are unable to answer the questions in the
Self-Check you will need to re-read the relevant Information Sheet. Once you have
completed all the questions check your answers by reading the relevant Answer Keys
found at the end of this module.

Next move on to the Job Sheets. Job Sheets provide detailed information about how
to do the job you are being trained in. Some Job Sheets will also have a series of
Activity Sheets. These sheets have been designed to introduce you to the job step by
step. This is where you will apply the new knowledge you gained by reading the
Information Sheets. This is your opportunity to practise the job. You may need to
practise the job or activity several times before you become competent.

Specification sheets, specifying the details of the job to be performed will be provided
where appropriate.

A review of competency is provided on the last page to help remind if all the required
assessment criteria have been met. This record is for your own information and
guidance and is not an official record of competency

When working though this Module always be aware of your safety and the safety of others in
the training room. Should you require assistance or clarification please consult your trainer or
facilitator.

When you have satisfactorily completed all the Jobs and/or Activities outlined in this
module, an assessment event will be scheduled to assess if you have achieved competency
in the specified learning outcomes. You will then be ready to move onto the next Unit of
Competency or Module
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Module Content

Unit Title: Create Mock Up and Print
Unit Code: OU- ICT-GD-04-L3-V1
Module Title: Creating Mock Up and Print

Module Description: This module covers the knowledge, skills and attitude required to create
mock up and print. This covers competencies on preparing the work environment, creating mock
up and printing draft.

Nominal Duration: 40 Hours

Learning Outcomes:
Upon completion of this module the trainees must be able to:

1. Prepare the work environment
2. Create mock up
3. Print draft

Assessment Criteria:

1. Design details of the graphic design project are reviewed to identify preference setting
requirements.

View magnification is set for ease of working with the graphics application.
Product shots are collected/taken.

A separate layer is prepared.

Screen layer is made.

Housekeeping/organizing work is done.

Mock up is completed and saved.

Printer is selected

Print preview option is accessed

10 Document is adjusted where necessary

11. Printout is taken

©® N oA WD



Learning Outcome 1: Prepare the work environment

Assessment Criteria

1. Design details of the graphic design project are reviewed to
identify preference setting requirements.

2. View magnification is set for ease of working with the
graphics application.

Conditions and
Resources

Real or simulated workplace
CBLM

Handouts

Laptop

Multimedia Projector

Paper, Pen, Pencil, Eraser
Internet facilities

White board and marker
Audio Video Device

Contents

Plo®NOOTAwNE

Design details of the graphic design project

= Stationary
= Collaterals
= Flyers and leaflets
= Brochure, catalogue
= Book design, magazine
= Billboard, signage
= Packaging, label, sticker
= T-shirt Graphics
2. View magnification.

Training Methods

Discussion
Presentation
Demonstration
Guided Practice
Individual Practice
Project Work
Problem Solving
Brainstorming

Assessment Methods

Written Test
Demonstration
Oral Questioning
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Learning Experience 1: Prepare the work environment

In order to achieve the objectives stated in this learning guide, you must perform the
learning steps below. Beside each step are the resources or special instructions you will
use to accomplish the corresponding activity.

Learning Steps

Resources specific instructions

1. Student will ask the instructor
about creating mock up and
print

. Instructor will provide the learning materials

creating mock up and print

2. Read the Information sheet/s

. Information Sheet No:1- Prepare the work

environment

3. Complete the Self-Checks &
Answer key sheets.

. Self-Check No: 1- Prepare the work environment

. Answer key No. 1- Prepare the work environment

4. Read the Job/ Task sheet and
Specification Sheet

. Job/ task sheet and specification sheet

Task Sheet No:1-1: Design details of the graphic
design project.




Information Sheet 1: Prepare the work environment

Learning Objective:

After completion of this information sheet, the learners will be able to explain, define
and interpret the following contents:
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1.2
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Design details of the graphic design project to identify preference setting
requirements.
View magnification for ease of working with the graphics application

Design details of the graphic design project
1.1.1 Stationary

The term "stationary" refers to
a design element or layout that
remains fixed or unchanged,
typically used for stationery
items such as letterheads,
business cards, envelopes, and
other printed materials. A
stationary  design  often
includes the company or
individual's logo, contact
information, and  other
branding elements.

When creating a stationary
design in Illustrator, the stationary components are typically placed in a fixed
position on the artboard. This allows for consistent placement of elements across
different pieces of stationery, maintaining a cohesive and professional look.

Here are some key considerations when designing stationary in Illustrator:

Artboard setup: Begin by creating an appropriately sized artboard for the
specific stationery item you are designing, such as a letterhead or business card.
Logo placement: Position the company or individual's logo in a prominent and
consistent location across all stationary items. This helps reinforce brand
identity and recognition.

Contact information: Include relevant contact details, such as company name,
address, phone number, email, and website. Place this information strategically,
ensuring it is easily readable and not cluttered.



1.1.2

Typography and fonts: Use consistent typography and fonts throughout the
stationary design to maintain visual harmony. Choose fonts that reflect the
brand's identity and are legible across different printed materials.

Color scheme: Apply a consistent color scheme that aligns with the brand's
visual identity. This includes using the brand's primary and secondary colors
throughout the stationary design.

Layout and alignment: Pay attention to the overall layout and alignment of the
elements on the stationary items. Ensure proper spacing, alignment, and balance
to create a visually appealing design.

Bleed and margins: Consider the bleed and margins when setting up the artwork
for printing. Bleed refers to the extra area beyond the actual size of the stationary
item to account for any trimming that may occur during the printing process.
Margins are the safe zones within the artwork where essential information
should be placed to avoid any risk of being cut off.

File formats: Save your stationary design in appropriate file formats, such as
PDF, EPS, or high-resolution raster formats like TIFF or PNG. This ensures
compatibility with various printing processes and allows for easy sharing with
print vendors.

Collaterals

In the context of graphic design and

—
marketing, "collaterals" refer to a - " o ’N
= .

collection of promotional materials or - ==
assets that are used to support a brand or \ 4
communicate a specific message. These
materials are typically designed to be
consistent with the brand's identity and
serve various purposes such as
advertising, information dissemination,
or brand recognition. Adobe Illustrator is
commonly used to create collaterals due
to its versatile vector-based design
capabilities




1.1.3 Flyers and leaflets

Flyers and leaflets are popular promotional materials used to advertise events,
products, or services. They are typically printed on a single sheet of paper and
distributed to a wide audience. Adobe Illustrator is a powerful tool for designing
flyers and leaflets due to its versatile design capabilities.
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1.1.4 Brochure, catalogue

Brochures and catalogs are printed marketing materials used to provide detailed
information about products, services, or businesses. They are designed to
showcase multiple products or services in a visually appealing and organized
manner. Adobe Illustrator is a powerful tool for creating brochures and catalogs
due to its versatile design capabilities.




1.1.5

1.1.6

Book design, magazine

Book design and magazine layout are important aspects of graphic design that
involve arranging text, images, and other visual elements in an appealing and
cohesive manner. While Adobe InDesign is commonly used for extensive book
and magazine layouts, Adobe Illustrator can also be used effectively for specific
design elements within these projects.

freelancer

Billboards and signage

Billboards and signage are large-scale advertising and informational displays
that are typically placed outdoors or in public spaces. They are designed to
capture attention, convey messages clearly, and promote brands, products, or
events. Adobe Illustrator can be used to design billboards and signage,
leveraging its vector-based design capabilities.




1.1.7 Packaging, label, sticker

Packaging design, label design, and sticker design are important aspects of
product branding and marketing. Adobe Illustrator is a powerful tool for creating
these designs due to its vector-based capabilities and versatile design features.

1.1.8 T-shirt graphics

T-shirt graphics are designs or illustrations that are printed or embroidered onto
T-shirts to create visually appealing and unique apparel. Adobe Illustrator is a
popular tool for creating T-shirt graphics due to its vector-based design

capabilities.




1.2 View magnification
View magnification refers to the ability to zoom in or zoom out on your design to see
it at a larger or smaller scale. It allows you to focus on specific details or get an overall
view of your artwork.

Here's how you can use the view magnification feature in lllustrator:

Zoom In: To magnify your design and see it in more detail, you can use the
following methods:

Press the "+" key on your keyboard to zoom in.
Select the Zoom Tool from the Tools panel on the left side of the Illustrator interface.

Click on the area you want to zoom in on. You can also click and drag to define a
specific area to zoom in on.

Hold down the Alt key (Windows) or Option key (Mac) and use the scroll wheel on
your mouse to zoom in and out.

Zoom Out: To view your design at a smaller scale, use the following methods:
Press the "-" key on your keyboard to zoom out.

Select the Zoom Tool from the Tools panel and click on the area you want to zoom
out from. You can also click and drag to define a specific area to zoom out from.

Hold down the Alt key (Windows) or Option key (Mac) and scroll down on your
mouse scroll wheel to zoom out.

Actual Size: To view your design at its actual size, which is the size it will be
printed or displayed at, use one of these methods:

Press Ctrl+1 (Windows) or Command+1 (Mac) on your keyboard to view the actual
size.

Select the View menu at the top of the Illustrator interface, then click on "Actual Size".

Fit to Screen: To fit your entire design within the Illustrator window, use one of
these methods:



Press Ctrl+0 (Windows) or Command+0 (Mac) on your keyboard to fit the artboard to
the screen.

Select the View menu, then click on "Fit Artboard in Window"

Custom Zoom Levels: lllustrator also allows you to enter specific zoom levels to view
your design at a precise magnification. You can do this by selecting the percentage
value in the bottom left corner of the Illustrator interface and entering a custom value.
The view magnification feature in Illustrator gives you control over the level of detail
you want to see in your design. By zooming in or out, you can work on intricate
elements, inspect fine details, or get a comprehensive view of your artwork.

10



Self-Check Sheet - 1: Prepare the work environment

Questionnaire:

1. What is stationary design?
Answer:

2. Write some professional design work?
Answer:

3. Which purpose we use billboards and signage?
Answer:

4. What is view magnification?
Answer:

11



Answer Key - 1: Prepare the work environment

1. What is stationary design?

Answer: The term "stationary" refers to a design element or layout that remains fixed or
unchanged, typically used for stationery items such as letterheads, business cards,
envelopes, and other printed materials.

2. Write some professional design work?
Answer: Collaterals refer to a collection of promotional materials or assets that are used to
support a brand or communicate a specific message.

3. Which purpose we use billboards and signage?
Answer: Billboards and signage are large-scale advertising and informational displays that
are typically placed outdoors or in public spaces. They are designed to capture attention,
convey messages clearly, and promote brands, products, or events

4. What is view magnification?
Answer: View magnification refers to the ability to zoom in or zoom out on your design
to see it at a larger or smaller scale. It allows you to focus on specific details or get an
overall view of your artwork.

12



Task Sheet-1.1: Design details of the graphic design project

Objective: The objective of this job sheet is to guide you through the process of focusing on
the design details of a graphic design project. By following the steps outlined below, you will
learn how to pay attention to the crucial elements that contribute to the overall success and

impact of your design.

Working Procedure:

1 Understand the project requirements

2 Research and gather inspiration

3 Sketch and conceptualize ideas

4 Develop a visual hierarchy

5 Choose appropriate typography

6 Select color palettes

7 Refine imagery and graphics

8 Incorporate branding elements (if applicable)
9 Seek feedback and iterate

10 Prepare final deliverables

13



Learning Outcome 2: Create mock up

Assessment Criteria

Product shots are collected/taken.

A separate layer is prepared.

Screen layer is made.
Housekeeping/organizing work is done.
Mock up is completed and saved.

Conditions and
Resources

Real or simulated workplace
CBLM

Handouts

Laptop

Multimedia Projector

Paper, Pen, Pencil, Eraser
Internet facilities

White board and marker

Contents

Product shots
layer preparation.
Screen layer
Mock up

Training Methods

Discussion
Presentation
Demonstration
Guided Practice
Individual Practice
Project Work
Problem Solving
Brainstorming

Assessment Methods

WNPRP PN REONR|[APONPL(ONDOREONER A ®N R

Written Test
Demonstration
Oral Questioning
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Learning Experience 2: Create mock up

In order to achieve the objectives stated in this learning guide, you must perform the
learning steps below. Beside each step are the resources or special instructions you will
use to accomplish the corresponding activity.

Learning Steps Resources specific instructions
1. Student will ask the instructor | 1. Instructor will provide the learning materials
about creating mock up and creating mock up and print
print

2. Information Sheet No:2- Create mock up
2. Read the Information sheet/s

3. Self-Check No: 2- Create mock up
3. Complete the Self-Checks &

Answer key sheets.
y Answer key No. 2- Create mock up

4. Job/ task sheet and specification sheet

4. Read the Job/ Task sheet and Job Sheet No:2-1: Create a mock up Design
Specification Sheet

Specification Sheet: 2-1 Create a mock up Design

15




Information Sheet 2: Create mock up

Learning Objective:

After completion of this information sheet, the learners will be able to explain, define
and interpret the following contents:

2.1
2.2
2.3
2.4

2.1

Product shots.
Layer preparation.
Screen layer.
Mock up.

Product shots

Product shots refer to visual representations or images of a product that are created
using the software's tools and features. Product shots are often used for marketing
materials, e-commerce websites, catalogs, or any other medium where showcasing the
product's appearance is important.

To create product shots in Illustrator, you can follow these general steps:

« Set up the document: Start by creating a new document with appropriate dimensions
and settings for your intended use. Consider the desired size and resolution of the
product shots.

= Import or create the product image: If you have a high-quality photograph of the
product, you can import it into Illustrator using the File > Place command.
Alternatively, you can draw the product from scratch using Illustrator's drawing tools
if you prefer a more illustrative or stylized representation.

« Refine the product image: Use Illustrator's tools to refine and enhance the product
image. This can include adjusting colors, applying gradients or textures, adding
shading or highlights, and adding details to make the product visually appealing and
accurate. You can also use blending modes, transparency settings, and layering
techniques to achieve the desired effects.

= Create backgrounds or context: Depending on the purpose of the product shots, you
may want to create backgrounds or contextual elements to provide a sense of
environment or usage. lllustrator offers a range of tools and features to create
backgrounds, patterns, textures, or even simulate lighting effects to enhance the
visual impact of the product.

16



2.2

= Add text and branding: If needed, incorporate text elements such as product names,
descriptions, or branding elements like logos or slogans. Illustrator provides various
typography options to customize the appearance of the text to match your design
concept.

= Arrange and organize: Utilize Illustrator's layering system to organize different
elements of the product shot. This helps in maintaining a structured and editable file,
allowing you to easily modify or rearrange components as necessary.

= Export the product shot: Once you are satisfied with your product shot, you can
export it in a suitable format, such as JPEG or PNG, for use in your marketing
materials, website, or other mediums. Consider the required resolution and file size
based on the intended usage.

Layer Preparation

Create a New Layer:
Go to the bottom of the Layers Panel and click on the Create New Layer button that is
represented by a plus (+) icon. A new layer appears in the Layers Panel.

n <Path>

. <Polygon>

. <Ellipse>

. <Rectangle>
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Method 2 to Create a new layer:

Go to the top right corner of the Layers Panel. Then, click on the Layers Panel menu
represented by three horizontal lines. Next, click on New Layer in the dropdown
submenu.

New Layer...
New Sublayer...

<Path> Duplicate "Layer 1"

. <Polygon>

. <Ellipse>

- <Rectangle>

Options for "Layer 1"...

Make Clipping Mask

Create a new layer via the Layers Panel menu

Once you click New Layer, you will see another layer appears above the first original
layer in the Layers Panel. At the same time, the Layers Option dialog box appears. Key
in your desired layer name into the Name field of the Layers Option dialog box. You
can also change the color of the layer’s tag if you wish by clicking on the toggle
represented by a triangular arrow pointing downwards.

It’s a good idea to give each layer a different color and label every layer to differentiate
them. In this way, if your file has many layers, you can easily find the layers you want
to edit by referring to the Layers Panel.

Next, leave the other options as per default and click the OK button.
> $4 Layer Options

W e Name:
¢ I Layer 1

Y <path> Color: [ Light Red v

. <Polygon>
B <etipse> » (J Template [J Lock

© 06 6 6 0|6 E

. <Rectangle> Show Print
b

N
=
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Preview [ Dim Images to:
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2.3

Separate the Object from the First Layer

Now that you’ve created another layer, bring your cursor to the object that you’d like
to separate from the main layer. Next, click on the object, hold and drag the layer to the
new layer. Then, release your mouse or cursor and your object will be added to the new
layer.

. Layer 2
v i Layer 1
ﬂ <Pa[§|>

. <Polygon>

. <Ellipse>

- <Rectangle>

bE [ W

Repeat the same steps for the other objects under the same layer. You’ve successfully
separated your objects from the main layer into separate individual layers.

Screen layer

the term "screen layer" refers to a blending mode that can be applied to a layer or
multiple layers in a design. The Screen blending mode is one of the many blending
modes available in Photoshop that determines how the pixels of one layer interact with
the pixels of the underlying layers.

Here's what you need to know about using the Screen layer blending mode in
Photoshop:

Blending Mode: In Photoshop, blending modes determine how the colors and tones of
different layers interact with each other. The Screen blending mode specifically
enhances the brightness and lightness of the underlying layers while preserving the
highlights. It is often used to create a brightening effect or to overlay images with a
light, glowing appearance.

Effect: When you apply the Screen blending mode to a layer, the dark areas of that layer
become transparent, while the light areas blend with the layers below, creating a
brightened effect. The brighter the pixels in the layer, the more they will affect the
underlying layers.

19



Application: The Screen blending mode is commonly used in various design scenarios,
including adding light effects, creating soft glows, blending multiple images
seamlessly, or enhancing the brightness of an image without affecting the colors.

Layer Stacking: The effect of the Screen blending mode is influenced by the stacking
order of the layers in the Layers panel. Layers positioned below the layer with the
Screen blending mode will be affected, while layers above will not. Adjusting the
opacity of the screen layer can also control the intensity of the effect.

To apply the Screen blending mode to a layer in Photoshop:

= Open your design in Photoshop and ensure that the Layers panel is visible.

= Select the layer you want to apply the Screen blending mode to.

= In the Layers panel, click on the drop-down menu that displays the blending mode
(by default, it is set to "Normal™).

= Scroll down and choose the "Screen” blending mode from the list.

= Observe the changes in the appearance of the layer and its interaction with the
layers below.

Remember that the Screen blending mode is just one of many blending modes available
in Photoshop. Exploring different blending modes and experimenting with layer
combinations can help you achieve a wide range of creative effects and enhancements
in your designs.

2.3.1 Screen layer in Hlustrator

Screen layer refers to a layer that is used to simulate the appearance of a printed halftone
screen or a digital screen effect in your artwork. It is commonly used when creating
illustrations, designs, or artwork that needs to replicate the look of a printed or digital
screen, such as retro-style graphics or comic book illustrations.

2.3.2 Create a screen layer in Illustrator, you can follow these steps:

= Create or import your artwork: Start by creating or importing the artwork
that you want to apply the screen effect to. This can be any vector artwork,
shapes, or text.

= Create a new layer: Open the Layers panel in Illlustrator (Window > Layers)
and create a new layer above the artwork layer. This new layer will be used to
apply the screen effect.

= Apply the screen pattern: Select the new layer and choose the "Appearance™
panel (Window > Appearance) to access the layer's appearance settings. In the

20



2.4

Appearance panel, click on the "Add New Fill" button to add a new fill attribute
to the layer.

= Choose the screen pattern: With the new fill selected, you can modify its
attributes in the Appearance panel. Click on the "Opacity" option and reduce the
opacity to a value that suits your desired screen effect. Then, click on the "Fill"
option and choose "Pattern™ from the drop-down menu.

= Access the pattern options: Once you have selected the pattern fill, click on
the "Pattern Options" link in the Appearance panel to access the pattern settings.

= Selectascreen pattern: In the Pattern Options dialog box, you can choose from
a variety of predefined screen patterns available in Illustrator. These patterns
simulate the appearance of printed halftone screens or digital screens. You can
select the pattern that best matches the effect you want to achieve.

= Adjust pattern settings: Customize the pattern settings as needed. You can
modify the size, spacing, angle, and other attributes of the screen pattern to
control the intensity and appearance of the effect. Preview the changes in real-
time to achieve the desired result.

= Fine-tune the appearance: After applying the screen pattern, you can further
refine the appearance by adjusting other attributes in the Appearance panel. You
can modify the blending modes, opacity, and other effects to enhance the overall
visual impact.

Mock up

In graphic design, a mockup refers to a visual representation or prototype of a design
concept. It is essentially a realistic or scaled-down model of a design idea that allows
designers to showcase how the final product may look and feel. Mockups are widely
used in various design disciplines, including web design, product packaging,
advertising, and branding.

Mockups serve several purposes in the design process:

= Visualization: Mockups help designers and clients visualize the design concept in a
more tangible and realistic manner. By presenting a design in a mockup, designers
can convey their ideas effectively and enable clients to provide feedback based on a

visual representation.

= Design Evaluation: Mockups allow designers to evaluate the aesthetics,
composition, and overall effectiveness of a design before investing time and

21



resources into the final production. They provide an opportunity to identify potential
design flaws or areas that need improvement.

= Communication and Collaboration: Mockups serve as a common ground for
designers, clients, and stakeholders to discuss and collaborate on design ideas. They
provide a shared visual reference, facilitating clearer communication and
minimizing misunderstandings.

= User Testing: In digital design, such as web and app interfaces, mockups are often
used for user testing. By creating interactive or clickable prototypes, designers can
simulate user interactions and gather valuable feedback on usability and
functionality.

Mockups can be created using various design tools, such as graphic design software,
prototyping tools, or even physical materials like paper and foam boards. They can
range from low-fidelity sketches or wireframes to high-fidelity, pixel-perfect
representations with detailed visual elements.

2.4.1 Creating a Mockup

Create the First Pouch Bag Design Template
Step 1

= To begin drawing the first part of the first plastic pouch packaging mockup,
create a rectangle, coloring it with #EEEEEE. Then, take the Mesh Tool
(U) and, following the picture below, create a mesh grid.

= Next, using the Mesh Tool (U), bend the rectangle to resemble the shape in the
third section of this step. You can achieve it by moving the edge Mesh nodes.

= To get rounded corners just like those in the bottom part of the shape, I

recommend first converting the corner nodes with the Convert Anchor Point
Tool (Shift-C).

1@ o 0
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Step 2

= Now let's start coloring the mesh grid! Using either the Mesh Tool (U) or the
Direct Selection Tool (A), select the mesh nodes selected in section 1 of the
screenshot below. Color these nodes with #DBDBDB via the Color Picker

panel.

= Next, add some more mesh nodes and bend them accordingly to achieve the
shape shown in the second section below.

= When you're happy with your shape, color some more nodes (selected in the
third section) with #D1D1D1.

Step 3

Finish this part of the plastic pouch packaging mockup by coloring the remaining nodes
according to the screenshot below. You will need these colors:

= #C6C6CH
= #F2F2F2
=  #DO0ODODO
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Step 4

To make the second part of the flat bottom pouch mockup, create a grey (#{DADADA)
rectangle with a mesh grid, and then bend it and color it according to the screenshot
below. You will need these colors:

- #DADADA
= #C6C6C6

- #EAE4E4

= #F2F2F2

' 1 et Ors o A
2 G . e i, I3 ! 0 T

Step 5

Attach both parts of the packaging bag mockup we've made so far. Bend and color the
edge nodes so that they overlap and create a seamless illusion!

For easier manipulation, you can Group (Control-G) both elements.

+—t v + b PR L 3

.4 4% 1

H—31 = o D
o B + gl "

+

4
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Step 6

Create the third part of the plastic pouch packaging mockup with Gradient Mesh,
following similar steps as in Steps 1 to 5. Use these colors:

=  #D3D3D3
= #/B7B7B
= #929292

= #9D9D9D
= #9FOF9F

- #BDBDBD

Step 7

Add the third part of the pouch packaging mockup to the others, just like in Step 5,
completing the pouch mockup!
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Step 8

Use the Rotate Tool (R) to rotate the finished flat bottom pouch mockup by -4°.

Step 9

Draw a shadow with aRadial Gradient from #979797 to white. Change
its Transparency mode to Multiply. Then, place the shadow under the stand-up pouch

template.

Step 10

The first packaging bag mockup should come out looking like this!
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Create the First Pouch Bag Design Template

Step 1

Let's start the creation of the second packaging bag mockup by drawing a rectangle! For
this element, we will need to use a rectangle with rounded edges.

You can use my measurements below with the Rounded Rectangle Tool. Once you're happy
with your shape, color it with #D9D9D9.

= Width: 122 px
= Height: 253 px
= Corner Radius: 4 px

- -

~ ™

Rounded Rectangle

Width: | P

Height: [ 2530x |

Comer Radius: | ¢ px |

I oK ] I Cancel ]

Step 2

Continue by bending and coloring the shape with Gradient Mesh, creating the first piece of
the stand-up pouch template.

=  #FOFOFO

= #C3C3C3
= #CCCCCC
- #EAE4E4
= #E3E3E3
= #D7D7D7
= #C7CTC7
= #D3D3D3
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Step 3
Next, create the side of the pouch mockup. You will need these colors:

- #B6B6B6
#9A9A%A
#ABABAB
#AAAAAA
#969696
#C7C7C7

il
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Step 4

For the third element of the packaging bag mockup, use these measurements:

= Width: 220 px
= Height: 150 px
= Corner Radius: 10 px

Rounded Rectangle

Step 5

Bend the rectangle and then color it with Gradient Mesh.

= #CCCCCC
= #FFFFFF

= #9D9D9D
= #AFAFAF
- #ECECEC
= #969696




Step 6

In the Transparency panel, change the resulting element's Transparency Mode to Multiply
and its Opacity to 40%.

W

LW I
i

jill
)

Step 7

To create the pouch mockup, put all the elements together, as shown below. Make sure that
element 3 stays on top of the other pieces!




Step 8

To finish the pouch packaging mockup, place a shadow under it, just as we learned in the
previous section.
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Self-Check Sheet - 2: Create mock up

Questionnaire:

1. What is product shot?
Answer:

2. What is Mockup?
Answer:

3. What is EPS?
Answer:
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Answer Key - 2: Create mock up

1. What is Content in lllustrator?

Answer: Product shots refer to visual representations or images of a product that are created
using the software's tools and features. Product shots are often used for marketing materials,
e-commerce websites, catalogs, or any other medium where showcasing the product's
appearance is important.

2. What is Mockup?

Answer: Mockup refers to a visual representation of a design or layout that is created using
the software's tools and features. Illustrator is a powerful vector graphics editor that allows
designers to create precise and scalable artwork, making it a popular choice for creating
mockups for various design projects.

3. What are the uses of screen layer?

Answer: Screen layer refers to a layer that is used to simulate the appearance of a printed
halftone screen or a digital screen effect in your artwork. It is commonly used when creating
illustrations, designs, or artwork that needs to replicate the look of a printed or digital screen,
such as retro-style graphics or comic book illustrations.
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Job Sheet-2.1: Create a Mockup Design

Working Procedure:

Follow OSH and use Personal Protective Equipment (PPE).

Start the Computer.

Read and follow the Specification Sheet.

Open Adobe Photoshop and create a new document and set up the workplace.
Separate images as per specification.

Retouch images as per specification.

Apply color correction images as per specification.

Apply effects as per specification.

© 00 N oo o B~ W N P

Save the document using the default file format of your Photoshop software.

10 Turn off the computer and clean your workplace

Sample job
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Specification Sheet-2.1: Create a Mockup Design

Necessary Personal Protective Equipment (PPE)

SI. No | Name of PPE Unit Quantity
1 | Ergonomic Chair No 1
2 | Eye protective glass No 1
3 | Rubber shoe Pair 1
Necessary tools and equipment
Name of Tools & e . i
SI. No Equipment Specification Unit Quantity
1 Personal Computer or Set 1
Laptop
2 Keyboard and Mouse Optical mouse No. 1
3 Monitor No. 1
Necessary materials
SI. No. | Name of materials Specification Unit Quantity
1 Simple Image A4 Paper No. 1
2 MS- Office Software No. 1
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Learning Outcome 3: Print Draft

Assessment Criteria

N

Printer is selected

Print preview option is accessed
Document is adjusted where necessary
Printout is taken

Conditions and
Resources

Real or simulated workplace
CBLM

Handouts

Laptop

Multimedia Projector

Paper, Pen, Pencil, Eraser
Internet facilities

White board and marker

Contents

Printer selection

Print preview option
Document adjustment
Printing procedure

Training Methods

Discussion
Presentation
Demonstration
Guided Practice
Individual Practice
Project Work
Problem Solving
Brainstorming

Assessment Methods

WP IONORAWNREIROWNEREIOCNDOORAWDNRE

Written Test
Demonstration
Oral Questioning

36




Learning Experience 3: Print Draft

In order to achieve the objectives stated in this learning guide, you must perform the
learning steps below. Beside each step are the resources or special instructions you will
use to accomplish the corresponding activity.

Learning Steps Resources specific instructions
1. Student will ask the instructor | 1. Instructor will provide the learning materials
about creating mock up and creating mock up and print
print

2. Information Sheet No:3- Print Draft
2. Read the Information sheet/s

3. Self-Check No: 3- Print Draft
3. Complete the Self-Checks &

Answer key sheets. i
swer key sheets Answer key No. 3- Print Draft

4. Job/ task sheet and specification sheet

4. Read the Job/ Task sheet and Job Sheet No:3-1: Print a document using printer

Specification Sheet o _ )
Specification Sheet: 3-1 Print a document using

printer
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Information Sheet 3: Print Draft

Learning Objective:

After completion of this information sheet, the learners will be able to explain, define
and interpret the following contents:

3.1
3.2
3.3
3.4

3.1

Printer selection

Print preview option
Document adjustment
Printing procedure

Printer selection

Printer selection refers to the process of choosing the appropriate printer settings and
configurations when preparing your artwork for printing. The printer selection ensures
that your design is compatible with the specific printer you plan to use, and it helps
optimize the output quality and accuracy of your printed materials.

To select the printer settings in Illustrator, you can follow these general steps:
Open the Print dialog box: Go to File > Print or use the keyboard shortcut Ctrl+P
(Windows) or Command+P (Mac) to open the Print dialog box in Illustrator.

Choose the printer: In the Print dialog box, select the printer from the available list of
installed printers. Make sure the selected printer is the one you intend to use for printing
your artwork.

Set the paper size and orientation: Specify the paper size and orientation that matches the
size and orientation of the paper you plan to use for printing. You can choose from a list
of standard paper sizes or set custom dimensions if necessary.

Configure print options: Depending on your printer and the desired output, you can adjust
various print options in the Print dialog box. These options may include print quality,
color management, paper type, print mode (e.g., duplex printing), and other printer-
specific settings. Refer to your printer's documentation for guidance on the specific
settings it supports.

Preview and adjust print settings: Use the Print Preview option in the dialog box to get a
preview of how your artwork will appear when printed. Take this opportunity to review
the page layout, scaling, and other settings. If needed, make adjustments to ensure the
desired appearance and fit on the printed page.
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Print the artwork: Once you are satisfied with the printer settings and preview, click the
"Print" button to initiate the printing process. Ensure that your printer is properly
connected, powered on, and loaded with the appropriate paper.

Print Preset: [Default]

Printer: Kyocera TASKalfa 5003i KX
Adobe PostScnpt® hile

General OneNote (Desktop)
Microsoft XPS Document Writer

Microsoft Print to PDF
Artboards: Fax

Copies:

__| Ignore Artboards

Media Size: Defined by Driver v

3.2 Print preview option

The Print Preview option allows you to preview how your artwork will appear when
printed before actually sending it to the printer. It provides a visual representation of the
layout, colors, and overall appearance of your design as it would appear on the printed
page. The Print Preview option helps you identify and address any potential issues or
adjustments needed before printing, ensuring that you achieve the desired output.

To access the Print Preview option in Illustrator, you can follow these steps:

= Open the Print dialog box: Go to File > Print or use the keyboard shortcut Ctrl+P
(Windows) or Command+P (Mac) to open the Print dialog box in Illustrator.

= Enable Print Preview: In the Print dialog box, you will find a checkbox or option
labeled "Print Preview" or "Preview" (the exact wording may vary depending on the
version of Illustrator). Ensure this option is checked or enabled.

= Adjust print settings if necessary: Before proceeding to the Print Preview, you can
configure the printer settings, paper size, orientation, and other options in the Print
dialog box according to your requirements. Make any necessary adjustments before
proceeding to the next step.
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View the Print Preview: Once you have enabled the Print Preview option, you can see
a preview of your artwork as it would appear on the printed page. The Print Preview
window displays your design within the defined page boundaries, taking into account
the selected printer settings and paper size.

Zoom and navigate the preview: In the Print Preview window, you can use the zoom
and navigation tools to examine different parts of your artwork. This allows you to
closely inspect details, check alignment, verify colors, and ensure the overall layout
matches your expectations.

Make adjustments if needed: While in Print Preview, you can identify any issues that
may affect the printed output, such as improper scaling, overlapping elements, or
unexpected color variations. If necessary, return to the Print dialog box to adjust
settings or make changes to your artwork in Illustrator to address these issues.

Exit Print Preview: After reviewing the Print Preview and making any necessary
adjustments, you can close the Print Preview window.

P’ General

Marks and Bleed Copies: (| Reverse Order

Output
Graphics Artboards:

Color Management [] Ignore Artboards

Media Size: Defined by Driver v

Orientation: & Auto-Rotate

Options

Print Layers: Visible & Printable Layers

Pla::ernent:ggg X: Opt Y. Opt

Scaling: Do Not Scale

Scale:
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3.3

Document adjustment

Document adjustment refers to the process of modifying the settings and properties of an
existing document to meet specific requirements or preferences. These adjustments can
include changing the document size, orientation, color mode, artboard settings, and other
aspects that affect the overall appearance and functionality of the document.

To perform document adjustments in lllustrator, you can follow these steps:

= Open the document: Launch Adobe Illustrator and open the document you want to
adjust. You can do this by selecting "Open™ from the File menu or by using the
keyboard shortcut Ctrl+O (Windows) or Command+O (Mac).

= Modify document size: To adjust the document size, go to the "Document Setup”
menu by selecting File > Document Setup. In the Document Setup dialog box, you
can change the width and height of the document in different units of measurement.
Remember to maintain the aspect ratio if you want to preserve the proportions of your
artwork.

= Adjust orientation: In the Document Setup dialog box, you can also change the
document orientation between portrait and landscape. Simply select the desired option
under the "Orientation” section.

= Modify color mode: If you need to change the color mode of the document, go to the
Document Setup dialog box and select a different color mode from the "Color Mode™
drop-down menu. Common color modes include RGB (for screen-based designs) and
CMYK (for print-based designs).

= Adjust artboard settings: The artboard represents the printable area of your document.
To modify the artboard size or position, select the "Artboard Tool" from the Tools
panel. With the tool selected, you can click on the artboard and adjust its dimensions
or position using the handles and controls that appear.

= Additional document adjustments: Depending on your specific needs, there may be
other adjustments you can make to the document. For example, you can change the
ruler units, set the document resolution, adjust the bleed settings, or specify the
number of artboards if you need multiple pages or views.

= Save the adjustments: Once you have made the necessary adjustments to the

document, remember to save your changes by selecting "Save" or "Save As" from the
File menu. This ensures that your modifications are retained for future use.
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3.4 Printing procedure

Step-1:

Click File from the tab bar at the top of the window and click Print once your document

is ready for printing.

Step-2:

Select the printer you wish to use under the Printer heading. Here, a self-serve laser

printer is selected.

Step-3:

To change the default duplex print setting to single-sided printing, click Setup located in

New from Template...
Open..
Open Recent Files

Close

Close Al
Save

Save As...
Save a Copy.-

Save as Template..

Search Adobe Stock...
Place..

Export

Scripts

Document Setup...
Document Color Mode
File Info..

Ctri+N
Shift+Ctri+N
Crl+O

CtrisW
Alt+Cirl«W
Cri+S
Shift+«Ctri+S
Alt+Ctri+S

Shift«Ctri+P

Alt+Ctri+P

Alt+Shift+Ctri+l

Print..

Ctri+pP

Exit

the bottom left corner of the Print window.
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Print

Print Preset: [Custom]

Printer: \\TSI-CFAP-03\CCSITXT

Geneal General
Setp

Macks and Bleed

s Copies: [ olfat Reverse Order
Graphs Pages
Coloe Management Pages: « Al 4 4 51 ) )
Advanced Z v
Sunmary Range: F N ~
Sequence: 'All Pages v
« Pages
Spreads

Print Master Pages

Options
Print Layers: Visible & Printable Layers
Print Non-printing Objects
Print Blank Pages
Print Visible Guides and Baseline Grids

Save Preset.. Cancel

Step-4:

Once the Print menu appears, select the printer you wish to use from the drop-down menu
provided under the Printer heading. In this tutorial, a Self-Serve Laser printer is selected.

Warning

If the desired print setting is available in InDesign’s Print dialog
A box, please setit there to avoid printing conflicts.

(] Don't show again

Step-5:
Make sure the correct printer is selected before proceeding. Different Adobe applications
use different commands to access the Printing Preferences window.

For Adobe Acrobat XI Pro, Flash, Dreamweaver, and Fireworks click Properties.
For InDesign and Illustrator click Preferences.

For Photoshop click Print Settings.

See the images below for an example of each.

Printing from Adobe Acrobat X1 Pro
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Print
@

P PR Sl [\ TSI- CEAP-O3\CCSITXT. i~ Propenties | [ Pavencea | Help
Copies: l.\ [= i e Raint o ale (black and white)

Pages to Print Comments & Forms

< Al [Do«ument and Markups v]

0 Current page
nes [ Summarize Comments ]

> Pages ll -4

> More Options Scale: 96%

Page Sizing & Handling &) 8.5 x11 Inches
F@ Size ] [ 85 Poster ] [ [E] Muntipte ] I [=] Bookiet ]

© Fit

) Actual size

© Shrink oversized pages
) Custom Scale: 100 %
[ ] Choose paper source by PDF page size

[~] Print on both sides of paper
© Flip on long edge ) Flip on short edge

Orientaticn:
@) Auto portrait/landscape
0 Portrait

< Landscape

Pagel of &

) Cee)

Step-6:

From the Printing Preferences window, select your preferred 2-sided printing method of
printing.

e To print single-sided, select Print on one side only.

e To print double-sided (duplex), selectPrint on  both  sides.
Note: This dialog box will look the same for all printers that support duplex and
single-sided printing.

o 3
| =% Printing Preferences
Settings Web Help
Page Layout | Paper | Print Quality | Other Options |
Copies Orientation A
k23 © Poitrait
Copies : n % —
é =9 ©Landsospe Lewer %6 x 11 in
Copies - 1
[ ] Piint last page fist [ ] Rotate 180° Coliate - ofs
. — - — Prot Qussty ;. Draft
2-sided printing Multipage printing (N-Up)

(Duplex models only) Pager Type:  Use printer settings
S Pages per sheet : N\

aqa: ©) Use printer setlings T = =
= — =

@ 1-sided

ED @ 2-sided long edge

Q @) 2-sided short edge

[ More Page Layout Options... ]
LEXMARK Cox

Step-7:
Click OK to close the printing preferences window.

Step-8:
Click Print to send the document to the selected printer.
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Self-Check Sheet - 3: Print Draft

Questionnaire:

1. What is printer selection?
Answer:

2. What is print preview?
Answer:

3. Why we need to adjust document before printing?
Answer:
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Answer Key - 3: Print Draft

1. What is printer selection?

Answer: Printer selection refers to the process of choosing the appropriate printer settings
and configurations when preparing your artwork for printing.

2. What is print preview?

Answer: The Print Preview option allows you to preview how your artwork will appear
when printed before actually sending it to the printer. It provides a visual representation of
the layout, colors, and overall appearance of your design as it would appear on the printed

page

3. Why we need to adjust document before printing?

Answer: Document adjustment refers to the process of modifying the settings and properties
of an existing document to meet specific requirements or preferences. These adjustments
can include changing the document size, orientation, color mode, artboard settings, and
other aspects that affect the overall appearance and functionality of the document
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Job Sheet-3.1: Print a Document Using Printer

Working Procedure:

o a bk~ wbhPE

Connect printer with computer.
Install printer software.

Adjust printer settings.

Select paper

Print the document

Turn off computer safely.

Specification Sheet

o ~ w0 DR

Collect printer and printer driver
Install driver software in c drive
Set printer as default

Set A4 paper for printing

Print the document from photoshop.
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Specification Sheet-3.1: Print a Document Using Printer

Necessary Personal Protective Equipment (PPE)

SI. No | Name of PPE Unit Quantity
1 | Ergonomic Chair No 1
2 | Eye protective glass No 1
3 | Rubber shoe Pair 1
Necessary tools and equipment
Name of Tools & e . i
SI. No Equipment Specification Unit Quantity
1 Personal Computer or Set 1
Laptop
2 Keyboard and Mouse Optical mouse No. 1
3 Monitor No. 1
4 Adobe Photoshop No. 1
5 Printer diver software No. 1
6 Printer No. 1
Necessary materials
SI. No. | Name of materials Specification Unit Quantity
1 Simple Image A4 Paper No. 1
2 MS- Office Software No. 1
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Review of Competency

Below is yourself assessment rating for module “Creating Mock Up and Print”

Assessment of performance Criteria

Yes

No

Required Professional Design work are selected.

Appropriate Tools, Palette and arrange them as needed are identified.

Ruler/unit/Grids/Guides/Smart Guides as per requirement are set

Key Drawing / Design Layout are prepared

Marks are interpreted.

Layer lock is applied

Contents are inserted.

Color/Design/Pattern is applied.

Pathfinder to create complex Objects are used.

Font Attributes are applied as per requirement.

Zoom In-Out and Panning are used.

Design for further use is saved

Artwork and Preview is used.

Layer Hide-Unhide option is used.

Appropriate marks are used.

Outline and Group Created.

appropriate File Format Saved.

The image to recipient istransferred.

I now feel ready to undertake my formal competency assessment.

Signed:

Date:
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Reference

https://design.tutsplus.com/tutorials/how-to-create-a-mockup-in-illustrator--cms-
41326

https://99designs.com/blog/tips/creating-professional-mock-ups/
https://smartmockups.com/

https://www.visme.co/mockup-generator/
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https://99designs.com/blog/tips/creating-professional-mock-ups/
https://smartmockups.com/
https://www.visme.co/mockup-generator/
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The Competency Based Learning Material (CBLM) of ‘Create mock-up and print’
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